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Solution Overview
OneStream Application Control Manager is a MarketPlace solution designed to support and 
manage change requests and ensure the right level of control and governance over application 
changes.

With Application Control Manager, you can:

 l Import metadata from ERP, data warehouses, or MDM tools and synchronize changes to 
OneStream.

 l Provide an easy way for users to request changes to OneStream applications. For 
example, new or updated accounts, cost centers, other dimensions and user privileges.

 l Allow governance of user security creation and maintenance.

 l Utilize multi-level approval workflow for change requests.

 l Create audit reports on application change requests.

 l Manage metadata changes across environments (Dev-Test-Prod).
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Setup and Installation
This section contains important details related to the planning, configuring, and installation of your 
solution. Before you install the solution, familiarize yourself with these details.

Dependencies
Component Description

OneStream 7.1.0 
or later

Minimum OneStream Platform version required to install this version of 
Application Control Manager.

Microsoft SQL 
Server

2016 Standard 
SP1 or later

Application Control Manager requires an instance of Microsoft SQL 
Server 2016 Standard SP1 or later.

Select the Application Control Manager 
Development Location
Before beginning installation, decide whether to build the solution directly in the Production 
OneStream application or in a separate Development OneStream application. This section 
provides some key considerations for each option.

Production OneStream Application: The primary advantage of building the solution in a 
Production application is that you will not have to migrate the resulting work from a Development 
application. However, there are intrinsic risks when making design changes to an application used 
in a Production capacity and not advised.

NOTE: OneStream strongly recommends that you implement the solution in the 
Development environment with a fresh copy of the Production application before 
starting work.

Development OneStream Application: As a best practice, use the Development OneStream 
application to build the solution.
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Create the OneStream Development 
Application

 1. Ensure all the OneStream artifacts relating to Application Control Manager, such as 
Workflow Profiles and Entities, are in the Production application.

 2. Create a backup copy of your Production database or copy your Production OneStream 
application to your Development environment and rename it. This Development version will 
be used for your Application Control Manager project.

 3. It is suggested to temporarily increase the Database Command Timeout settings for the 
installation. This can be done in the OneStream Application Server Configuration Tool. In 
Database Connections under the Connection Strings section, set the Command Timeout 
and Command Timeout Large settings to 3600. These values can be reverted after the 
installation is complete.

Install Application Control Manager
 1. On the OneStream Solution Exchange website , go to MarketPlace > Application Control 

Manager.

 2. On the Application Control Manager Solution page, select the OneStream platform version 
from the Minimum Platform Version drop-down list.

 3. Select the most recent version from the Solution Version drop-down list and then click 
Download.

 4. Log in to OneStream.

 5. On the Application tab, click Tools > Load/Extract.

 6. On the Load tab, locate the solution package using the Select File icon and click Open.

 7. When the solution file name displays, click Load.

 8. Click Close to complete the installation.

 9. Click Application Control Manager Installer and expand the Application Control 
Manager Installer.
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 10. Click Step 1: Install.

 11. Click Proceed on the Installation Process Warning message.

 12. Close the dialog box when the installation process is complete.

 13. Refresh the application and navigate to OnePlace > Dashboards > Application Control 
Manager. You will see the solution.

NOTE: If you are upgrading from a previous version, you must close any existing 
and open requests from the previous version to complete the new installation. If an 
open request is detected, the installation process will stop and a log message will 
display in the Task Activity Log.

Set Up Application Control Manager
The first time you run Application Control Manager, tables are set up from the installer.

Package Contents
The Application Control Manager is the user interface for settings and application governance. 
The following Business Rules are included:

 l ACM_MetadataSource

 l ACM_DataSet

 l ACM_Reports

 l ACM_Config

 l ACM_Engine

 l ACM_FlowHelpers

 l ACM_Globals

 l ACM_Helpers

 l ACM_ItemHelper

 l ACM_Logging
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 l ACM_Objects

 l ACM_RequestHelper

 l ACM_SolutionHelper

 l ACM_SQLHelpers

 l ACM_Validations

 l ACM_Param

 l ACM_CreateFlowViews

 l ACM_CreateRequest

 l ACM_MetadataCommit

 l ACM_PrepareMetadata

The following items are included with the installation to import metadata from source.

 l Dimensions:

 o Entity dimension: ACM_MetadataImportMember

 o Scenario dimension: ACM_MetadataImportScenario

 o Account dimension: ACM_MetadataImportParent

 l Cubes

 o ACM_MetadataImport

 l Workflow Profiles

 o ACM_MetadataImport

 l Data Management Group

 o ACM MetadataImport

 l Parser
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 o ACM_ImportMetadata

 l Connector Business Rules:

 o ACM_AccountSource Business Rule

 o ACM_EntitySource Business Rule

 o ACM_UD1-8Source Business Rule

 l Transformation Rules:

 o ACM_ImportMetadata_View

 o ACM_ImportMetadata_Account

 o ACM_ImportMetadata_Entity

 l Transformation Rule Profile:

 o ACM_ImportMetadata

 l Standard default Metadata, Views, Properties, Validations, and Flows

Data Management Sequences and Steps are created for use with their related Business Rules. 
The benefit of running these processes through a Data Management Sequence is that they can 
run in the background while the user continues their work.

NOTE: It is not recommended to modify any standard default Dimensions, Flows, 
Views, or Properties provided with installation as they may get over-written during 
the upgrade. Make a copy of them with a different name instead.
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Application Control Manager 
Dashboard
Navigation Toolbar
In the Application Control Manager dashboard, use the toolbar icons to navigate to different 
pages.

 l Home: Manage requests: Create, edit, manage, view, claim, unclaim, pushback, reject, and 
commit.

 l Reports: Run reports on requests.

 l Administration (Administrator Only): Define and create request views, flows, dimensions, 
properties, and validations.

 l Settings (Administrator Only): Global settings for the solution. Most settings are configured 
once during the initial installation and do not need to be updated on an ongoing basis.

 l Help: View the Application Control Manager user guide.
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Home

Home Toolbar

 l Create: Create a new request.

 l Edit: Update an existing request.

 l Manage: Redirects to the Manage Request page to add and update items.
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 l View: View an existing request in read-only mode. Request Workflow and Save icons are 
not displayed, so the request cannot be edited.

 l Claim: Claims the request so the current user can work on it. Removes this request from 
the queue of other users.

 l Unclaim: Puts the request back into the queue as Unclaimed for other users to claim.

 l Pushback : Pushes the request back to a prior step.

 l Reject: Rejects and closes the request.

 l Commit: Manually launches the Commit Data Management sequence to commit all 
requests currently at the Commit step with a status of Waiting.

Request Filter Bar

 l My Requests: Shows requests the current user has created.

 l My Actions: Shows requests with pending actions for the current user.

 l My Queue: Shows requests for the current user when their group has the next pending 
action (for example, Enrich group).

 l Active Requests: Shows requests that are currently active (not in a closed, completed, or 
committed status).

 l All Recent: Shows all requests in any state from recent days as configured in the next 
option.
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 l
: Configures how many days to view in the All Recent filter.

Request Detail
On the Home page, you can view a request's line item details, document attachments, and activity 
log by clicking Show on the right side of the page. You can also hide the panel windows, or resize 
them to get more viewable space.

 l Items Table: Shows summary information of the items created on the selected request.

 l Documents: View documents attached to the selected request.

 l Request Activity: View the activity log for the selected request and add comments to it.
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Manage Request
On the Manage Request page, you can:

 l Move a request forward or backward in the request flow.

 l Reject a request.

 l Validate items in a request.

 l Create or delete request items.

 l Attach, delete, and download documents.

Request Summary and Workflow Buttons

 l Home: Redirects to the Application Control Manager Home page.

 l Request Summary

 o Request ID, Flow Name, Current Step

 l Request Workflow Buttons

 o Unclaim: Puts the request back into the queue as Unclaimed for other approved 
users to claim and redirects back to the Application Control Manager Home page.

 o Reject : Rejects and closes the current request. You can no longer edit the request 
after this action.

 o Pushback: Pushes the request back to the previous step in the request flow.

 o Validate Request: Checks the validation status of all items in the current request.

 o Submit: Moves the request to the next step in the request flow.
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Request and Document Buttons

 l Add: Opens a dialog box to create a new item.

 l Remove: Deletes the selected item.

 l Attach: Opens file explorer to attach a supporting document.

 l Delete: Deletes the selected document.

 l View: Downloads the selected document.

Item Table
The item table shows individual line items or changes that are associated with the request. A 
single request can contain multiple line items. The Items grid can displays unlimited rows and also 
allows you to export the data by right-clicking within the grid.

 l Item Group (not shown): For Grouped Request Types (such as Cost Center), shows the 
Item Name of the Group Parent Item.

 l SubItem (not shown): True/False, indicates if the item is a sub item of a Grouped Item. 
Only valid on Grouped Request Types.

 l Action: The metadata action to be performed at the Commit step.

 l Dimension: OneStream dimension to be updated at the Commit step.

 l Parent Name: OneStream parent member name.

 l Member Name: OneStream member name.
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 l Description: OneStream description.

 l Notes: An input text field that is specific to the particular item.

 l Validated: True/False, indicates if all item properties are valid.

 l Committed: True/False, indicates if an item has been successfully committed.

 l ParentInRequest: True/False, indicates if the Parent is included in the request.

Item Detail and Item Buttons
Enter or review properties for the item. Properties displayed here are set on the associated view.

 l Approvers: Add approvers to the current item.

 l Note: Enter a note for the current item.

 l Recalculate: Recalculates or refreshes the values for any calculated properties assigned 
to the view.

 l Validate: Runs validations assigned to the current item.

 l Save: Saves the current item properties.
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Request Activity
View a running log of the current request activity. Click Add Comment to include additional 
commentary for the request.

Reports
The Reports Page icon allows user to run, view, and export reports. Reports are displayed in grid 
or PDF view.

 l Metadata Bridge Report: Displays the requester, all metadata changes made, action and 
status in Application Control Manager.

 l Request Audit: Displays all requests made in a specified time (in days).

 l Request Audit by Request Type: Displays the audit report specified by request type.

 l Request Audit by Status: Displays the audit report by status.

 l Request Audit by Step Type: Displays the audit report by step type.

 l Automated Request Audit with Item Detail: Displays all requests that were automated 
from a source system into Application Control Manager.

 l Request Activity Audit: Displays all activity that has happened in a specified audit time (in 
days).

Application Control Manager Guide 14

Application Control Manager Dashboard



Export Report Data
To export the data from the Grid View tab, right click anywhere on the table, select Export and 
then select the format for export:

 l Excel XML

 l CSV

 l Text

 l HTML

To export the data from the Report tab, click on the Export selector from the toolbar and then 
select the format for export:

Administration
On the Administration page you can define controlled governance in Application Control 
Manager:
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 l Metadata: Set up dimensions, actions, and source system imports.

 l Security: Enable and disable allowed security actions.

 l Properties: Works with OneStream defined properties and custom properties.

 l Validations: Business rules can be set up to ensure user entry is appropriate.

 l Views: Create and edit views. Assign properties and validations to views.

 l Flows: Create the steps in the request approval process.

 l Reports: Create custom report sets.

 l Exports: Create and copy export groups and files.

 l Logs: View log details.

Metadata
Provides options for the metadata governance set up of Application Control Manager. There are 
three tabs for metadata information:

 l Dimensions

 l Actions

 l Source System Import

Dimensions Tab
Use this tab to define the dimensions that you want to be able to update in a request.
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 l Label: Unique label for the dimension. Click  to add a new dimension.    

 l Cube: Cubes in the current OneStream application.

 l Dimension: OneStream dimension types.

 l DimName: OneStream dimension names.

 l MemberFilter: Text input field to assign the default member filter associated with this 
dimension.

 l Grouped (visible if enabled in Global Options): Default is False. Set to True to create a 
Grouped Dimension type. If enabled, when a new item is created, an item is created for 
each dimension defined in the GroupedDim property. The Grouped dimension is not a true 
OneStream dimension and is not committed to the Metadata Dimension Library.

 l GroupDim (visible if enabled in Global Options): A comma-separated list of the dimension 
labels to group together.

Actions Tab
Use this tab to enable or disable actions.
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 l Name: Unique name for the action in Application Control Manager. These actions are not 
editable and do not allow additions.    

 l Label: Display name of the action in Application Control Manager.

 l Request Type: The type of request that uses the action in Application Control Manager.

 l Enabled: Enable or disable actions for your Application Control Manager design.

Source System Import Tab
Use this tab to manage source system import options of Application Control Manager.

 l Import: Import and upload an Excel template for Metadata.

 l Process: Launches the data management step selected in the table.

 l Clear Table: Erases the Metadata table for the selected data management step.
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NOTE: If you are using an Excel template, ensure that you have consolidated the 
varying properties into the Member tab and that you have appended the varying 
property updates. 

Retain Source System Order
The Source System Import sort order allows new members and existing members to import the 
custom order defined in the source system. Select Retain Source System Order to maintain the 
source system sort order.

 1. Go to Application Control Manager > Administration > Metadata > Source System 
Import.

 2. Select Retain Source System Order

Retain Source System import performs the following processes:

 l Imports the Metadata into the staging table with the sort order specified in the file.

 l Generates a request if the sort order is changed when imported.

 l Commits sort order changes in the correct order as specified by the import template.

Security
Allows you to enable or disable actions to govern user security-type requests. You cannot add 
actions.
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 l Name: Unique name for the action.

 l Label: Display name for the action.

 l Enabled: Enable or disable the action.

Properties
Properties table contains a list of fields that can be assigned to a view. Once assigned, users will 
be allowed to update the values of those properties. There are two types of properties:

 l OneStream defined properties, such as any of the built-in metadata properties. The 
following are default OneStream properties that are pre-installed in the table:

 o OneStream metadata properties for the supported dimensions.

 o OneStream relationship properties.

 o OneStream user security properties.

 l Custom properties leverage OneStream components to provide specific functionality for 
Application Control Manager. The following custom properties are pre-installed in the table:

 o Parent Member Selector: Member selector specifically for a Parent property, to 
distinguish from a default Member Selector for other properties.

 o Member Selector: Member selector that pulls properties from an existing member. 
This is used to create a new member in an alternate hierarchy.

 o Security Group Selector: Member selector that pulls from security groups.
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 o Alternate Hierarchy: Member selector that creates a copy of the current item and 
creates the new member in an alternate hierarchy.

 o Varying Member Property Selector: Member selector for selecting Scenario Type, 
Cube Type, or Time Value for varying properties.

You can also create and add custom properties in Application Control Manager to support your 
organization needs.

Properties Tab

Flow Type: Specifies the type of flow this property belongs to. Available options are: Metadata, 
Security, and Generic.

Property Name: Unique property name.

Label: Descriptive label to be used across the solution.

Flow Property: Indicates if the property can be assigned at the flow level.

Component Type: List of dashboard components you can assign to a view. These are the same 
as the default OneStream components:

 l Check Box

 l Combo Box

 l List Box

 l Member Selector

 l Text Box

Parameter Type: The type of parameter attached to the component:
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 l Literal Value

 l Input Value

 l Delimited List

 l Bound List

 l Member List

 l Member Dialog

Parameter Name: If necessary, select an existing parameter to populate choices in the delimited 
list and bound list.

Namespace: Indicates if the property is built in OneStream or is custom.

Default Value: Sets the default value for the property. The default value is blank.

Property Options (Optional): Name-value pairs used to override default settings throughout the 
solution. Property option values can be strings or parameters in the OneStream format, for 
example, |!ParameterName!|.

 l IsName: Indicates that this property is a Name property. Used for Custom Name properties.

 l IsDesc: Indicates that this property is a Description property. Used for Custom Description 
properties.

 l IsRef: Indicates that this is a Reference member.

 l IsParentName: Indicates that this property is a Parent Name. Used for Custom Parent 
properties.

 l PropName: Used for custom properties. Set the OneStream property this should update.

 l DimTypeName: Overrides the default DimTypeName on Member Selector type 
components.

 l Dimension: Overrides the default Dimension on Member Selector type components.

 l MemberFilter: Overrides the default MemberFilter on Member Selector type components.

 l CubeName: Overrides the default CubeName on Member Selector type components.

 l Tooltip: Sets the tooltip on the component.
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Varying Properties
The Varying Properties listed in the following categories can be added or modified using a user-
initiated metadata request or source system import request:

 l Vary by Cube Type

 l Vary by Scenario Type

 l Vary by Scenario Type and Time

The varying properties are differentiated by the following types:

 l Account

 o Member Properties

 o Relationship Properties

 l Entity

 o Member Properties

 o Relationship Properties

 l UDs

 o Member Properties

 o Relationship Properties

Non-varying Properties
The Non-varying Properties listed below can be added or modified using a user-initiated metadata 
request or source system import:

 l Entity

 o Position Within Parent

 o Position
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 o Default Parent

 o Parent Sort Order

 l Account and UDs

 o Position within Parent

 o Position

 o Aggregation

 o Aggregation Weight

Security Properties
The following are OneStream defined User Security properties that are pre-installed in the 
application. These properties can be assigned to a user-initiated request:

 l Culture

 l Description

 l Email

 l External Auth Provider Name

 l External Auth User Name

 l Grid Rows per Page

 l Security Groups

 l Enabled

 l User Name

 l Text 1

 l Text 2

 l Text 3

 l Text 4
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 l UserName

 l UserType

 o Interactive: Allows all functionality. The user type defaults to Interactive for new 
users and upgrades.

 o View: Allows users to view all data, reports, and dashboards in the production 
environment and the derived database. The View user privileges do not permit the 
authorized user to load, calculate, consolidate, certify, or change data.

 o Restricted: Assigns contractual limits for certain functional tasks, such as limiting 
rights to solutions such as Account Reconciliation or Lease.

 o Third Party Access: Allows OneStream access using a named account, and 
logging on interactively using a third-party application. There is no access using the 
OneStream Windows application or the OneStream browser interface. The user 
cannot change data or modify OneStream application artifacts.

 o Financial Close: Allows users to perform Account Reconciliation solutions or 
Transaction Matching.

Categories Tab
Property categories are used to organize similar properties or dimension-specific properties into 
groups. Category groups are listed on the left. The properties assigned to the group are on the 
right.

These property categories display when adding properties to views.
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Lists Tab
On the Lists tab, you can create name-value pair lists to be used as references in properties.  An 
example of how you might use a property list would be for a drop-down list in a property.

Click Create to create a new list.

 l Display: Display text that a user sees when interacting with the list. Click  to add a new 
list member.

 l Value: Value is used by the system when making changes.

Request Table and Item Table Tabs
The Request Table and Item Table tabs are system-generated and cannot be updated by the 
administrator.

Validations
Validations are business rules that run to verify that user input follows specific rules. A validation 
can be assigned to a property within a view. Application Control Manager is pre-installed with a list 
of default validations. You can also create and add custom validations to meet your organization 
needs.
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Name: Unique validation name.

Label: Description of validation.

Failure Message: Message that displays when the validation fails.

Class: All validations are set to script.

Parameters: The business rule and associated parameters needed to run the validation script.

Validation Assignment
There are two ways to assign a validation to a property in Application Control Manager, directly in 
the Validation administration page or using the View editor (refer to View editor section for more 
info).

Validations : Use this to select the view you want to assign the validation to.
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Properties : Once the view has been selected, use this to select the specific property to apply the 
validation.

Validation Business Rules
To run properly, all validation scripts should be created in the ACM_Validations business rule.

Views
A view is what you want a user to see at an Application Control Manager step. Properties and 
validations are assigned to views and then the view is assigned to a flow step.
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Views Tab
Click New and Edit to create and edit views.

Name: Unique view name.

Label: Description of view. It is helpful to include the dimension, step, and action.

Request Type: This is selected from a list after view creation. Available types are: Metadata, 
Security, and Generic.

View Editor
To see the details or to modify a view, select a view and then click Edit.

Properties Tab: Includes two lists: Available Properties and Assigned Properties.
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The Filter drop-down list allows you to switch between property categories to see which properties 
are available to assign to the view.

Use the center arrows to add or remove the selected property or all properties to or from the 
assigned properties list.

Use the Assigned Properties toolbar to:

 l : Move the selected property up in the display order.

 l : Move the selected property down in the display order.

 l
: Toggle the editable property for all assigned properties.

 l : Toggle the required property for all assigned properties.
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 l : Toggle the calculated property for all assigned properties.

 l
: Open a window to select an existing view from which to copy all properties.

After you assign the property to the view, configure the following settings:

 l Display Order: The order of properties displayed in the view. Duplication in display order 
will cause an error when processing source system import.

 l Editable: Indicates if the property can be edited.

 l Required: Indicates if the property is required. If True, it will not pass validation if a required 
property is blank.

 l Calculated: Indicates if the property is calculated based on another property.

 l Custom Label: Overrides the property label.

 l Options: Name-value pairs that are used for solution functionality.

 o Tooltip: Overrides the property tooltip.

 o UseRef: Use the property values from the Reference member assigned in the view.

 o DimTypeName: Overrides the DimTypeName for the property.

Validations Tab: Assign validations to views.
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 1. Use the arrows to assign validations to specific properties within the view. 

 2. Complete one of the following actions:

 l Select an assigned validation and then click the pencil to assign the validation to one 
or more properties. 
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 l Click Copy to copy validations from another view.

 l From the drop-down box, select the view to copy from and then click Copy 
Validations.

Flows
Flows represent the entire request approval process that a user completes when creating a 
request. You can define the steps or stages of the approval, notification setting for each step, 
security group, actions type, and views assignment for the Flow.

Flow Editor
New: Create a new flow.
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Edit: Edit a flow.

Copy: Copy a flow.

Create: Create dynamic dashboard components for the selected flow.

Create All: Create dynamic dashboard components for all flows.

Delete All: Deletes all dynamic dashboard components for all flows.

Export: Export flows to a .csv file for review in Excel or another text editor.

 l Name: Unique request flow name.

 l Label: Descriptive label that users see for the request type.

 l Category: Available options are: Metadata, Security, and Generic.

 l Security Group: Indicates who can initiate these types of requests.

 l Order: The order the request type displays in the drop-down list when a user creates a new 
request.

 l Enabled: Determines if the request type is visible in the new request drop-down list.

 l Multiple Items?: Determines if the request allows more than one item in the request.

 l Error Template: Email template sent out for errors at the flow level.

 l Use Tabs?: Determines if the flow is using multiple tab views.

 l Modify Approvers?: Determines if the user is allowed to select the approver from a drop-
down list.

 l Error Email: Email group that receives flow error emails.
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 l Edit Button: Allows you to add a flow property to the flow level.

 l Save Button: Saves updates made to the flow header.

Steps Tab

Steps represents the different stages a request should go through.

 l Order: Step order. The Initiate step is the first step and the Commit step is the last step for 
metadata requests. When creating flows on the Steps tab, the step order must be 
sequential and cannot be duplicated. Validations are present to ensure the step order and 
duplication are identified.

 l Step Type: These are the five available built-in step types.

 o Initiate

 o Process

 o Commit

 o Migrate

 o Export
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 l Label: Unique label for flow-step combination.

 l Security Group: Specify which group of users has access at each step.

 l Notify: Select who gets notified on this step.

NOTE: Not currently implemented, only notifies email address defined.

 o None, Assignees, Participants, Assignees and Participants

 l Email Template: Select the email template to use for notification.

 l Email Address: Email group to be notified when the request is at the current step.

Options Tab

For Metadata request types, assign the dimensions to work with on this request type and then 
assign the actions to perform for each dimension.

Assign Actions

Views Tab
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The Views tab allows administrators to assign the previously created views to each individual 
step-dimension-action in the flow process. If the views have not been created, you can also 
access the View Editor from here. The view assignment label list is automatically created when 
you add a new step or option. You must select the Assigned View from the drop-down list.

NOTE: Refresh: If the View Assignment list looks incorrect or not up to date, click 
Refresh to manually refresh the list.

New: Create a view.

Edit: View the details or edit an assigned view. Select the view step and then click Edit. 

Create: Create dynamic dashboard components for the flow.

Create Dynamic Dashboard for Flow Views
After you create the flow and assign the views to each flow step, or anytime after you modify the 
flow options, you must run a process to create the dashboard components. Go back to the main 
Flows screen, select the flow, and click Create.
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The dynamic dashboards are created in a specific Dashboard Maintenance Unit named 
Application Control Manager Dynamic Dashboards (ACM). The dashboards can be reviewed 
here.

IMPORTANT: Do not make updates to the Dashboard here because any changes are 
overwritten when the Create process runs. Only make updates using the View or Flow 
Editor.

Reports Setup
The Reports page allows you to set up report sets for access through the Application Control 
Manager Reporting page. A set of defaults reports are pre-installed with the application (refer to 
the Reports section for more info). You can also create custom report to meet your organization 
needs (refer to Create Custom Reports section for more info). 
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Report Sets
Use to group Application Control Manager reports into report sets. 

 l : Add a new report set.

 l  : Delete a selected report set.

 l  : Undo unsaved changes.

 l  : Save changes to the report sets.

The workspace has three main columns:

 l Name (Key): Unique name for the report set.

 l Description: More detailed description of the report set.

 l Display Order: Arrange your report sets in numerical order.

Reports
When you click on a report set, the lower pane opens where you can add the reports to the set.
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 l  : Add a report to the set.

 l  : Delete a selected report from the set.

 l  : Undo unsaved changes.

 l  : Save changes to the report.

The dashboard has six columns:

 l Name(Key): Unique name for the report.

 l Display Name: The name of the report displayed to the end user.

 l Enabled: Determines if the report in the set can be seen by the end user.

 l Display Order: Arranges reports in numerical order.

 l Security Group: Assigns the OneStream security group that can view this report.

 l Dashboard Name: Name of the report dashboard in Application Control Manager.

The reports dashboard groups are in Application > Presentation > Dashboards > Application 
Control Manager (ACM).

There are reports that come with Application Control Manager and are listed under Default 
Reports.
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Exports
On the Exports page, you can create and copy export groups and files.

 l File Name: The title of the file.

 l Export Location: The file location after it is exported.

 o Local

 o User Folder

 o File Share
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 o Application Database

 o External

 l File Path: The location of the file.

 l File Extension: File extension examples are .txt. and .csv.

 l Delimiter: Delimiters are used to separate the export properties on file.

 l OverwriteFile: If selected, the file can be overwritten.

 l HasHeader: Indicates if the file has a header row.

 l PropsInRow: If selected, properties in the row can be set.

 l FilterActions: This setting is used to specify if only certain actions are allowed to get 
exported. If not selected, all actions are included in the file.

 l FileActions: Actions that can be added to the file such as add, modify, and remove.
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Logs
Application Control Manager has detailed logging where administrators can view all of the 
processing events including errors that have occurred in the solution.

NOTE: Detailed Logging check box must be checked off under Global Options.

 

Click Refresh to refresh the detailed logging screen. Click Delete to clear all Application Control 
Manager  log files.

 l Message Time: Time stamp for the activity.

 l Log Level: Captures the type of Log item that was written (for example, Information, 
Warning, Error, or Fatal).

 l Category: The organization of the system type that generated that Log Entry.

 l Business Rule: Business Rule responsible for writing the Log Entry.

 l Log Message: Description of the activity.

 l User Name: Login name of the user who performed the activity.

 l Exception Trace: The full path of the error. These breadcrumbs lead to the error.

Settings
The Settings page contains global solution configuration settings including initial setup, uninstall, 
and custom database table administration.
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Global Setup
Most global settings are configured once during the initial installation and do not need to be 
updated on an ongoing basis. There are five tabs under the Global Setup:

Global Options
Global configuration options apply to the entire solution.

 l Time Offset: Use to adjust the server time to the current time zone. This is the time stamp 
used on all activities in the solution. The value is the number of hours to adjust and can be a 
positive or negative number.

 l Detailed Logging: Enable Logs under the Administration menu.

 l Grouped Dims: Enable when one request needs to be applied to multiple dimensions.

After Grouped Dims is enabled, the Grouped Dim column is visible on the Dimensions tab on the 
Metadata page under Admin.

Then the admin can enter multiple dimensions in the Grouped Dim columns. If there is a Grouped 
Dim assigned to a Flow, there will be one item created at initiation for the Grouped Dim that the 
user can enter data into. After the Request is moved to the next step, there are items created for 
each of the dimensions that make up the Grouped Dim. The Enricher or Approver will see two or 
more items that match up with that grouped dimension.

Global Security
The global security tab is where you can assign security on who can manage Application Control 
Manager.
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 l Security Role [Manage Setup]: Select the OneStream security group that will be the 
Application Control Manager Administrator.

Email Settings
Email settings allow you to set up the email server account used to send notifications from 
Application Control Manager. If this is the first time installing Application Control Manager, it is a 
good idea to click on the Save button under the email setting to register the email server with the 
application.

 l Server Config Name: Uses the email connection defined on the OneStream server. Or you 
can set up a manual connection by filling in this information:

 o Email server: Email service address

 o Email Port: Port used by the email server settings

 o From Address: Email address which the messages should come from.
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 o Username: Email username for the account

 o Password: Password for email account

Email Templates
Templates that are used for email notifications. Different email templates can be assigned to each 
stage of the request. You can create new templates using the placeholders in the subject and 
message of the email. 

 

Here's a sample email content:

Email Placeholder Options

 l FlowName

 l FlowType

 l FlowLabel

 l FlowStepLabel
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 l FlowStepType

 l Message

 l Priority

 l PriorFlowStepLabel

 l RequestID

 l Requester

 l RequestStatus

 l RequestReason

 l RequestNextAction

 Environments
Administrators can set up multiple environments to move metadata across environments. This 
environment configuration is required to utilize the Migrate functionality.

Load/Extract
This screen allows you to load and extract components or the entire Application Control Manager 
user interface.

Extract
Use to extract the configuration and components of Application Control Manager.
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 l Extract: Select the specific configuration piece that you want to extract to a flat file for future 
import or backup.

 l Extract All Config Data: Extracts all pieces of Application Control Manager configuration 
to a flat file for future import or backup.

Load
Use to delete and load the Application Control Manager configuration and components.

 l Delete Config Data: Clears all current Application Control Manager configuration data 
(Metadata, Properties, Validations, Views, Flows). Use this before importing new 
configuration data from file.

 l Load Data: Imports configuration data from file.
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Uninstall
 1. In the Application Control Manager Dashboard, click  and then, under Settings, click 

Uninstall.

 2. Select an option:

 l Uninstall UI to remove the dashboards, business rules and keep all the data in the 
database tables. This is useful when upgrading to a newer version of the  solution.

NOTE: All open requests in Application Control Manager must be 
closed before performing an Uninstall UI.

 l Uninstall Full to completely uninstall the solution including all components and data. 
Thisuninstalls the custom database tables and removes all dashboards. You can’t 
recover from this unless you have backed up both the dashboards and data.
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Administration Tasks
Create a New View
To create a new view for a Metadata request type:

 1. Go to Administration  > Views.

 2. Create a new view.

 3. Select Metadata from the Flow Type.

 4. Click Save (this will allow you to add the Properties and Validations).

 5. Move the corresponding property over. Use the Filter drop-down to toggle between different 
categories.

 6. Save the view and close the View Editor.

To create a new view for a Security request type:

 1. Go to Administration > Views.

 2. Create a new view.

 3. Select Security from the type.

 4. Move the corresponding property over. Select Security from the Filter drop-down to see 
relevant properties.

 5. Save the view and close the View Editor.

Create a New Flow
To create a new flow for a Metadata request type:

 1. Go to Administration  > Flows.

 2. Create a new flow .
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 3. Create Name and Label (recommended to be the same).

 4. Select Metadata from the Category list.

 5. Click Save (this will allow you to add the Steps, Options, and Views).

 6. On the Steps tab, add the steps for your approval workflow.

 7. On the Options tab, assign the Dimension and Actions combination for this flow.

 8. After all steps and options are added, on the Views tab, select the Assigned View for each 
Step and Option combination. (See Create a New View).

 9. Ensure the flow is enabled to make it available in the New Request drop-down list.

 10. Save the flow and close the Flow Editor.

 11. Run the Create Flow Views process.

To create a new flow for a Security request type:

 1. Go to Administration > Flows.

 2. Create a new flow.

 3. Create Name and Label (recommended to be the same).

 4. Select Security from the Category List.

 5. Click Save (this will allow you to add the Steps, Options, and Views).

 6. On the Steps tab, add the steps for your approval workflow.

 7. On the Options tab, assign the Security Actions for this flow.

 8. After all steps and options are added, on the Views tab, select the Assigned View for each 
Step and Option combination. (See Create a New View ).

 9. Ensure the flow is enabled to make it available in the New Request drop-down list.

 10. Save the flow and close the Flow Editor.

 11. Run the Create Flow Views process.
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Refreshing Dynamic View Dashboards
 1. Make the changes to the flow that you want to update. Changes can be updating a label, 

adding or removing a property, changing the order of the properties, adding or removing 
steps in a flow, and views assignment.

 2. Go to Administration> Flows.

 3. Select the flow that you changed.

 4. Click Create. 

TIP: To refresh all dynamic dashboards, click Create All.

Create Custom Reports
You can add custom reports using combinations of business rules, dashboard data adapters, 
dashboard components, and dashboards.

NOTE: Any custom reports that use custom components are removed when 
performing an Uninstall UI. The ACM_Reports business rule is overwritten during 
an upgrade. Any customizations to this business rule must be backed up and 
merged into the updated business rule.

Follow the sample steps below to add a new custom report to show the values of the custom 
properties FlowReason and FlowPriority.

 1. Add the report definition to the ACM_Reports by navigating to Business Rules > Dashboard 
Data Set > ACM_Reports.

 2. Add the report to the list of reports. Be sure to add the comma to the previous line.
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 3. Copy and paste rows 112-121 and update for the new report name.

 4. Insert the following code after line 331:

private DataTable GetMyCustomReport1(SessionInfo si, string startTime, string endTime)
{
    try
    {
        using (DbConnInfo dbConnFW = BRApi.Database.CreateFrameworkDbConnInfo(si))
        {
            using (DbConnInfo dbConnApp = BRApi.Database.CreateApplicationDbConnInfo(si))
            {
    endTime = endTime.Replace("/", "-") + " 23:59:59";
 
    // Create the data table to return
    var sql = new System.Text.StringBuilder();
                sql.Append("Select r.ID, r.RequesterID, r.Status, ");
                sql.Append("'Commit' As StepType, f.Label, r.LastModified, ");
                sql.Append("'" + startTime + "' As CriteriaStartTime, ");
                sql.Append("'" + endTime + "' As CriteriaEndTime, ");
            //For item level properties, use i.ItemProperties instead of r.RequestProperties
                sql.Append("JSON_Value(r.RequestProperties, '$.Properties.FlowReason') As 
FlowReason, ");
                sql.Append("JSON_Value(r.RequestProperties, '$.Properties.FlowPriority') As 
FlowPriority ");
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            //FOR ITEM LEVEL PROPERTIES, UNCOMMENT NEXT 2 LINES
                // sql.Append("From " + ACM_Globals.m_ItemView + " i ");
                // sql.Append("RIGHT Join " + ACM_Globals.m_MasterRequestView + " r On i.FKRequestID 
= r.RequestID ");
                sql.Append("From " + ACM_Globals.m_MasterRequestView + " r ");
                sql.Append("INNER JOIN " + ACM_Globals.m_StepTable + " s ON r.FKStepID = s.StepID 
");
                sql.Append("INNER JOIN " + ACM_Globals.m_FlowTable + " f ON r.FKFlowID = f.FlowID 
");
                sql.Append("WHERE s.StepType = 3 AND r.Status = 'Completed' AND ");
                sql.Append("r.LastModified >= '" + startTime + "' And r.LastModified <= '" + endTime 
+ "' ");
                sql.Append("ORDER BY r.LastModified DESC");        
 
                using (var dt = BRApi.Database.ExecuteSql(dbConnApp, sql.ToString(), false))
                {
                    dt.TableName = "MyCustomReport1";
                    return dt;
                }
            }
        }
    }
    catch (Exception ex)
    {
        Logger.Write(si, "Error getting Activity Log Report.", ACM_Globals.LogLevel.ERR, ACM_
Globals.LogCategory.AcmReports, ex);
        throw ErrorHandler.LogWrite(si, new XFException(si, ex));
    }            
}

This is what it will look like in the business rule:

        private DataTable GetMyCustomReport1(SessionInfo si, string startTime, string endTime)
        {
            try
            {
                using (DbConnInfo dbConnFW = BRApi.Database.CreateFrameworkDbConnInfo(si))
                {
                    using (DbConnInfo dbConnApp = BRApi.Database.CreateApplicationDbConnInfo(si))
                    {
                        endTime = endTime.Replace("/", "-") + " 23:59:59";
 
                        // Create the data table to return
                        var sql = new System.Text.StringBuilder();
                        sql.Append("SELECT r.ID, r.RequesterID, r.Status, ");
                        sql.Append("'Commit' AS StepType, f.Label, r.LastModified, ");
                        sql.Append("'" +  startTime + "' AS CriteriaStartTime, ");
                        sql.Append("'" + endTime + "' AS CriteriaEndTime, ");
                    // For ITEM LEVEL Properties, use i.ItemProperties instead of 
r.RequestProperties
                        sql.Append("JSON_Value(r.RequestProperties, '$.Properties.FlowReason') AS 
FlowReason, ");
                        sql.Append("JSON_Value(r.RequestProperties, '$.Properties.FlowPriority') AS 
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FlowPriority ");
                    // For ITEM LEVEL Properties, UNCOMMENT NEXT 2 LINES
                        // sql.Append("FROM " + ACM_Globals.m_ItemView + " i ");
                        // sql.Append("RIGHT JOIN " + ACM_Globals.m_MasterRequestView + " r ON 
i.FKRequestID = r.RequestID");
                        sql.Append("FROM " + ACM_Globals.m_MasterRequestView + " r ");
                        sql.Append("INNER JOIN " + ACM_Globals.m_StepTable + " s ON r.FKStepID = 
s.StepID ");
                        sql.Append("INNER JOIN " + ACM_Globals.m_FlowTable + " f ON r.FKFlowID = 
f.FlowID ");
                        sql.Append("WHERE s.StepType = 3 AND r.Status = 'Completed' AND ");
                        sql.Append("r.LastModified >= '" + startTime + "' AND r.LastModified <= '" + 
endTime + "' ");
                        sql.Append("ORDER BY r.LastModified DESC");
 
                        using (var dt = BRApi.Database.ExecuteSql(dbConnApp, sql.ToString(), false)) 
                        {
                            dt.TableName = "MyCustomReport1";
                            return dt;
                        }
                    }
                }
            }
            catch (Exception ex)
            {
                throw ErrorHandler.LogWrite(si, new XFException(si, ex));
            }
        }

5. Compile the business rule to check the syntax.

Add Reports to the Application Control Manager 
Custom Dashboard
Add the reports to the Application Control Manager Custom dashboard as follows:

 1. Click Application Dashboards > Dashboard Maintenance Units > Data Adapters.

 2. Click Create Data Adapter.
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 3. Enter a name for the data adapter.

 4. For Command Type select Method.

 5. For Method Type select Business Rule.

 6. For Method Query, click the ellipsis and add the following:

{ACM_Reports}{MyCustomReport1}{StartTime=|!Report_StartDateTime_ACM!|, 
EndTime=|!Report_zEndDateTime_ACM!|}

 7. In Results Table Name enter MyCustomReport1.

 8. Click Test Data Adapter to test the adapter.
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You should see similar results to this:

Creating a Grid View Component
Perform the following steps to create a Grid View component.
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 1. Select Components and click Create Dashboard Component.

 2. Scroll to select Grid View.

 3. Input a Name and Description for the Grid View. Prefix components, using, in this case, 
“gv_” for Grid View. Click OK.
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 4. Click Data Adapters , the + icon, MyCustomReport1 Data Adapter, then OK.

 5. Navigate to and expand Dashboard Groups.

 6. Select Custom Reports and click Create Dashboard .

 7. Click Save.

 8. Click Add Dashboard Component.

 9. Select gv_MyCustomReport1.

 10. Click OK, then Save.
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 11. Test the dashboard by clicking View Dashboard.

A successful dashboard test would look like this:

Complete the Configuration
Once your dashboard tests successfully, finish the configuration in Application Control Manager.

 1. Return to the Application Control Manager dashboard.

 2. Click Administration.

 3. Click Reports.

 4. Add a new Report Set by clicking +.
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 5. Name the Report Set, give it a Description, and assign a Sort Order (this is for display 
order).

 6. Click Save.

 7. Highlight the MyCustomReports row in the Report Sets table.

 8. Click + in the MyCustomReports table.

 9. Fill out the information, selecting the dashboard you created from the drop-down in the 
Dashboard Name field.

 10. Click the table Save button.

 11. Navigate to Reports.

 12. Change the drop-down from Default Report Set to Custom Report Set.

 13. Select the Flow Details report set.

 14. View the report.

Setup Email Notification
You can set up an email server in the Application Server Configuration Tool and then create the 
connection in the OneStream Windows Application. The name for the Database Server 
Connection must match the Server Config Name. If you do not know the name, contact 
OneStream Support.
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OneStream Windows Application
If you are an administrator in OneStream, you can find the name through the following:

 1. Navigate to System > Administration > System Configuration > Database Server 
Connections.

 2. Click Create Item to add a new server.

 3. Enter a name for the server.

 4. Set the Database Provider Type to EMAIL.

 5. Enter a connection string.

 6. Reset the server.

Email Settings in a Flow
You can set an email address in each step of the flow from the Flows tab under Administration.

 1. Ensure the email server configuration is updated in Administration > Global Setup > 
Email Settings. (See Email Settings section for more info.)

 2. Navigate to Administration > Flows.
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 3. Select a flow and click Edit.

 4. 

 5. Enter an email under Error Email.

 6. Enter an email address in each step on the Flows.
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Metadata Import
Set Up Data Sources
When Application Control Manager is installed, a default set of data connectors is installed. There 
is one connector for each supported dimension:

These data sources are set up to connect to Application Control Manager staging tables, which 
are created during the installation process. These staging tables are named with the following 
format: ACM_Metadata<dimension>ImportTree and ACM_
Metadata<dimension>ImportMembers.
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The tables with Members in the name store the unique list of members from the source metadata 
system. Each dimension table has a different set of properties, including various properties 
related to the member, that you can import into OneStream.

The tables with Tree in the name store the Metadata relationship details, parent, and child. Each 
table contains a different set of properties, including relationship properties, that you can import 
into OneStream.
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The Dimension column must be populated with the Label of the Application Control Manager 
dimension that you are loading. This is set up in the Administration > Metadata > Dimensions 
page.

The Parent and Child columns are populated with member names found in the Member column of 
the associated Members table. SortOrder can be used to sort the hierarchy. If order is not 
important, enter a value of 1 for all rows in the hierarchy table.

To load Metadata details to the tables mentioned above, you can either modify the Data 
Connector to pull from a specific file, or you can use an Excel template and upload the metadata 
into Application Control Manager using the Source System Import tab.
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Workflow Profiles
When Application Control Manager is installed, a Workflow Profile named ACM_MetadataImport_
Default is automatically created in your system. In addition, a unique cube is created:  ACM_
MetadataImport. 

By default, the data source name for each dimension is set to use default data connectors 
configured during installation. 
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Select the transformation profile named ACM_ImportMetadata. This is automatically created in 
your environment when Application Control Manager is installed.

The Workflow Profiles are used to import the metadata loaded in the Application Control Manager 
staging tables into the OneStream staging tables. After the information is loaded, the metadata is 
analyzed to determine differences that exist between the source data and the metadata stored in 
OneStream. The system looks for differences in this order:

 1. Missing members in the metadata compared to the source system.

 2. Existing members that need to be moved or copied to a different hierarchy.

 3. Updates to existing member properties.

If Application Control Manager finds any updates, it generates a request in the application. The 
results of this process are displayed on the main home page of Application Control Manager.

Global POV Time
When running a source system import, the system loads the data in the current year and month 
staging tables, and the Global Time is set to a full year.

If Enforce Global POV is set to TRUE, the load process uses the value set in the Global POV. If 
the Global POV is set to a date format other than YYYYMM, an error occurs because the 
OneStream Software workflow profile will not load properly.
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If Enforce Global POV is set to FALSE, the data management source system import process 
ignores any Global POV settings and instead uses the system date and time to determine the 
period for loading data.

Metadata Import Fields
To map the import data to the metadata properties in OneStream, go to the Application Control 
Manager Administration screen and select Views. A single view for each workflow profile is 
created when Application Control Manager is installed and these views contain every property 
related to the dimension. To customize these views, create a new view and use the Copy 
Properties button to copy the properties that you can then modify accordingly.

If you click on Edit on the default Views, on the right side of the View Editor, you can see the list of 
metadata properties that map in the same order as the default Data Connectors.

 

These properties also match the information in the database tables:
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Member 
Properties for 
Account

 

  l "Member"

 l "Description"

 l "Text1"

 l "Text2"

 l "Text3"

 l "Text4"

 l "Text5"

 l "Text6"

 l "Text7"

 l "Text8"

 l "UD1Constraint"

 l "UD2Constraint"

 l "UD3Constraint"

 l "UD4Constraint"

 l "UD5Constraint"

 l "UD6Constraint"

 l "UD7Constraint"

 l "UD8Constraint"

 l "EnableUD1Aggregation"

 l "EnableUD2Aggregation"
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 l "EnableUD3Aggregation"

 l "EnableUD4Aggregation"

 l "EnableUD5Aggregation"

 l "EnableUD6Aggregation"

 l "EnableUD7Aggregation"

 l "EnableUD8Aggregation"

 l "EnableICAggregation"

 l "EnableOriginAggregation"

 l "EnableFlowAggregation"

 l "UsedOnEntityDim"

 l "UsedOnConsDim"

 l "IsConsolidated"

 l "FlowConstraint"

 l "ICConstraint"

 l "ICMemberFilter"

 l "AllowInput"

 l "WorkflowChannel"

 l "InUse"

 l "DisplayMemberGroup"

 l "FormulaType"

 l "Formula"

 l "FormulaForCalculationDrillDown"
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 l "AdjustmentType"

 l "InputViewForAdj"

 l "NoDataZeroViewForAdj"

 l "NoDataZeroViewForNonAdj"

 l "AccountType"

 l "IsICAccount"

 l "UseAltInputCurrencyInFlow"

 l "PlugAccount"

 l "AggregationWeight"

 l "CubeType"

 l "ScenarioType"

 l "TimeVal"

Member 
Properties for 
Entity

 

 

  l "Member"

 l "Description"

 l "Text1"

 l "Text2"

 l "Text3"

 l "Text4"

 l "Text5"
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 l "Text6"

 l "Text7"

 l "Text8"

 l "UD1Constraint"

 l "UD2Constraint"

 l "UD3Constraint"

 l "UD4Constraint"

 l "UD5Constraint"

 l "UD6Constraint"

 l "UD7Constraint"

 l "UD8Constraint"

 l "UD1Default"

 l "UD2Default"

 l "UD3Default"

 l "UD4Default"

 l "UD5Default"

 l "UD6Default"

 l "UD7Default"

 l "UD8Default"

 l "Currency"

 l "IsConsolidated"

 l "IsIC"
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 l "FlowConstraint"

 l "ICConstraint"

 l "AllowAdjustments"

 l "ICMemberFilter"

 l "InUse"

 l "AllowAdjustmentsFromChildren"

 l "DisplayMemberGroup"

 l "ReadDataGroup"

 l "ReadDataGroup2"

 l "ReadWriteDataGroup"

 l "ReadWriteDataGroup2"

 l "UseCubeDataAccessSecurity"

 l "CubeDataCellAccessCategories"

 l "CubeConditionalInputCategories"

 l "CubeDataManagementAccessCategories"

 l "SiblingConsolidationPass"

 l "SiblingRepeatCalcPass"

 l "AutoTranslationCurrencies"

 l "DisplayMemberGroup"

 l "ParentSortOrder"

 l "CubeType"

 l "ScenarioType"
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 l "TimeVal"

Member 
Properties for 
UD1

 

  l "Parent"

 l "Member"

 l "Description"

 l "Text1"

 l "Text2"

 l "Text3"

 l "Text4"

 l "Text5"

 l "Text6"

 l "Text7"

 l "Text8"

 l "UD2Constraint"

 l "UD3Constraint"

 l "UD4Constraint"

 l "UD5Constraint"

 l "UD6Constraint"

 l "UD7Constraint"

 l "UD8Constraint"

 l "UD2Default"
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 l "UD3Default"

 l "UD4Default"

 l "UD5Default"

 l "UD6Default"

 l "UD7Default"

 l "UD8Default"

 l "IsConsolidated"

 l "AllowInput"

 l "WorkflowChannel"

 l "InUse"

 l "AlternateCurrencyForDisplay"

 l "DisplayMemberGroup"

 l "FormulaType"

 l "IsAttributeMember"

 l "AttributeMemberSourceMember"

 l "AttributeMemberExpressionType"

 l "AttributeMemberRelatedDimType1"

 l "AttributeMemberPropType1"

 l "AttributeMemberComparisonText1"

 l "AttributeMemberOperatorType1"

 l "AttributeMemberRelatedDimType2"

 l "AttributeMemberPropType2"
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 l "AttributeMemberComparisonText2"

 l "AttributeMemberOperatorType2"

 l "Formula"

 l "FormulaForCalculationDrillDown"

 l "AggregationWeight"

 l "CubeType"

 l "ScenarioType"

 l "TimeVal"

Member 
Properties for 
UD2-8 fields

 

  l "Parent"

 l "Member"

 l "Description"

 l "Text1"

 l "Text2"

 l "Text3"

 l "Text4"

 l "Text5"

 l "Text6"

 l "Text7"

 l "Text8"

 l "IsConsolidated"
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 l "AllowInput"

 l "WorkflowChannel"

 l "InUse"

 l "AlternateCurrencyForDisplay"

 l "DisplayMemberGroup"

 l "FormulaType"

 l "IsAttributeMember"

 l "AttributeMemberSourceMember"

 l "AttributeMemberExpressionType"

 l "AttributeMemberRelatedDimType1"

 l "AttributeMemberPropType1"

 l "AttributeMemberComparisonText1"

 l "AttributeMemberOperatorType1"

 l "AttributeMemberRelatedDimType2"

 l "AttributeMemberPropType2"

 l "AttributeMemberComparisonText2"

 l "AttributeMemberOperatorType2"

 l "Formula"

 l "FormulaForCalculationDrillDown"

 l "AggregationWeight"

 l "CubeType"

 l "ScenarioType"
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 l "TimeVal"

NOTE: If you want to change the list of properties monitored and updated in 
OneStream, you can create a new View and then use the Copy Properties button to 
copy the properties from the default view. Then, you can remove the property or 
change the order of the property. To change the order of the property, use the arrow 
buttons to move fields in and out of the list.

NOTE: If you are using a customized view, you must modify the related Connector 
Business Rule.

In the Connector business rules, find the GetFieldList method and associated method containing 
the SQL to pull information from the database in GetSourceDataSQL.

NOTE: Make sure the fields match the order that Application Control Manager has 
in the associated view.
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Data Management Groups
The process of loading and committing metadata updates to OneStream is handled using Data 
Management steps and sequences. 

The data management steps are preconfigured when Application Control Manager is 
installed. The Load items are set up to execute the workflow profile associated with the dimension 
name. The process loads the data from the database into the Application Control Manager 
staging tables, performs the comparison process, and builds a request if necessary.

The associated Workflow Profile is in the Parameters on the data management step:
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 l WorkflowProfileName: Specify the name of the dimension you are importing for. This 
matches the Workflow Profile as well as the WF Profile Name in the Metadata Import Fields 
screen.

Ensure the Business Rule is set to ACM_MetadataImport.

The execution of the steps Load <…> perform the following steps:

 1. Loads the data from the database or file into the workflow for the current global POV time 
and scenario.

 2. Compares the data loaded into staging to the existing OneStream members for the 
selected dimension and determines which members need to be added.

 3. Compares the data loaded into staging to the existing OneStream hierarchy for the selected 
dimension and determines which updates are required to the overall hierarchy.

 4. Compares the data loaded into staging to the existing OneStream members and 
determines which properties need to be modified.

 5. Compares the existing members and hierarchy in OneStream to the data loaded into the 
staging to determine which members need to be removed from the hierarchy. Any member 
not in the import file/table is marked as orphaned in OneStream. The member is not 
deleted.

 6. Generates an Application Control Manager request that performs all the required 
operations in a single transaction.

After a request has been generated, the Commit All Metadata Updates data management step 
runs to commit the updates to the system.

The Data Management Steps can be combined into a sequence to enable the full automation of 
the process using a PowerShell script and the Windows Task Scheduler on the OneStream 
application server. You can automate the load and commit steps to include no user interaction 
before commit or you can set the system up to require an individual on the Finance team to review 
the request before manually committing it into the system.
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Metadata Synchronization
Initial Setup and Configuration
The metadata migration and synchronization feature of Application Control Manager keeps the 
metadata hierarchies between two OneStream installations/applications aligned with one 
another. This is accomplished by using the REST API built into OneStream. The configuration is 
completed in the destination environment. The REST API in the source environment requires 
setup on the server side to ensure that the correct configuration is in place and to request the 
following details for your Azure Single Sign-on configuration from your technical support 
representative:

 l Azure AD Tenant ID

 l OneStream Web API Client ID

 l OneStreamWeb API Client Secret Key

 l Source OneStream System URL

 l Source OneStream System Application Name

The first three values can be found in the OneStream WebServerconfig.xml:
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Set Up Remote Source Server Environment
First, you must set up a Remote Source Server Environment to start Migration.

 1. Navigate to Settings > Global Setup > Environments.

 2. Click + in Name Table Editor.

 3. Create and enter an Environment Name under the Name field.

TIP: Remember the Environment Name. This will be used in future steps.

 4. Save the Environment Name.

Create Environment Options
Next, you must create the Environment that surrounds the source system.

 1. Click + in Options / Value Table Editor.

 2. Click the Option column to display the list for the Environment Options.

NOTE: If the remote server is a OneStream IdentityServer (OIS) with a personal 
access token (PAT), only the ClientUrl, ClientApp, and PAT options are necessary.

NOTE: If the remote server is a Legacy Azure SSO Environment, TenantID, 
ClientID, ClientKey, ClientUrl, and ClientApp options are necessary. PAT is not 
needed.
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TenantID, ClientID, ClientKey, and ClientUrl can all be found in the Server XFConfig file under the 
following keys:

 l TenantID = AzureADTenantId

 l ClientID = AzureADClientId

 l ClientKey = AzureADWebApiSecretKey

 l ClientUrl = XFWebApiUrl (only the URL's protocol and domain are needed)

 l ClientApp is the remote server's application that is being used for the Migration.

Data Management Job Configuration
The metadata synchronization process is run using a Data Management job in OneStream. When 
Application Control Manager is installed, a Data Management Group named Application Control 
Manager Metadata Migration (ACM) group containing associated steps is automatically created:
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As with other features in Application Control Manager, there is a step associated with each of the 
dimensions in OneStream.

To complete the setup, you must update the Parameters section of the step. The 
EnvironmentName parameter is entered in the initial setup step from Application Control 
Manager:

The WorkflowProfileName is always Migration and the FlowName is the flow name you created 
previously. These two values should not be changed.

Execution
When any of the Load <dimension name> steps are executed, the following processes occurs:
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 l Prepare metadata on remote (source system)

 o Using the REST API that was configured in the Application Control Manager system 
administration screen, the system remotely executes a Data Management setup on 
the source system named Application Control Manager Metadata Migration (ACM) -> 
Prepare Metadata.

 o This process gathers all metadata information including the member list, hierarchy, 
and properties for the dimension specified in the workflow profile. This information is 
stored in a temporary staging table in the database.

 l Retrieve metadata from a remote system

 o Using the REST API, make a built-in API call named 
GetAdoDataSetForSqlCommand on the remote system. The system pulls the 
information and loads it into the local (destination) OneStream application database 
for further processing.

 l After the data is loaded into the database, the same processing that occurs during a 
metadata import takes place. If any updates are required, the system automatically 
generates a request, which can be committed using the Application Control Manager 
Metadata Migration (ACM) -> Commit All Metadata Updates Data Management step.

Configure Flows With Migration Step
Application Control Manager can migrate requests from one OneStream environment to another. 
You can use this as a testing feature to see how metadata updates will impact a production 
system before committing them in that environment. You can also use it to keep two systems 
synchronized with each other.

Before continuing, follow the setup steps outlined in the Metadata Synchronization section. You 
must set up a destination environment where requests will be sent.

If you have a large data set to migrate (>100k of data), make sure to increase your Command 
Timeout or Task Inactivity Timeout (minutes) settings under Database Server Connections > 
Connection String Settings > Command Timeout or Application Server Configuration Settings > 
Task Inactivity Timeout (minutes).

Add a new step to any flow you have configured in the system. In the Application Control Manager 
administration screen, select Flows and edit or create a flow to use for the migration. Add a new 
step to the flow after the Initiate step and select Migrate.
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Click Edit:

Specify the destination system to commit the request. This was defined in the prior configuration 
step.

Select the target environment:

When you create a new request in the system and advance from the initiate step, you will see the 
system report the next step to be Migrate:
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When you manage this request and advance to the next step, the system automatically connects 
to the target environment REST API and pushes the request information from the source system 
to the destination environment and automatically commits the request. After reviewing and testing 
in that environment, return to the source system and continue processing as you typically would.
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Help & Miscellaneous Information
This page contains solution documentation.

Display Settings
OneStream and MarketPlace solutions frequently require the display of multiple data elements for 
proper data entry and analysis. Therefore, the recommended screen resolution is a minimum of 
1920 x 1080 for optimal rendering of forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text setting to 
100% and do not apply any Custom Scaling options.

Package Contents & Naming Conventions
The package file name contains multiple identifiers that correspond with the platform. Renaming 
any of the elements contained in a package is discouraged in order to preserve the integrity of the 
naming conventions.

Example Package Name: ACM_PV7.1.0_SV101_PackageContents.zip

Identifier Description

ACM Solution ID

PV7.1.0 Minimum Platform version required to run solution

SV101 Solution version

PackageContents File name
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Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution with custom 
tables such as this one. The relationship between OneStream objects such as workflow profiles 
and custom solution tables is that they point to the underlying identifier numbers and not the 
object names as seen in the user interface. Prior to the solution configuration and to ensure the 
identifiers match within the development and production applications, the development 
application should be a recent copy of the production application. Once the development 
application is created, install the solution and begin design. The following process below will help 
migrate the solution tables properly.

See also: Managing a OneStream Environment in the Design and Reference Guide.

 1. In the production OneStream application, install the solution and create the data tables. 
See "Setup and Installation" on page 2 for Database Server Connection settings and 
installation details.

 2. Data tables are created in the OneStream Development application during the solution 
installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to 
the Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator 
should run the migration assistant.

IMPORTANT: This process has the potential to overwrite existing table data in the 
production application database if data already exists.

MarketPlace Solution Modification 
Considerations
A few cautions and considerations regarding the modification of MarketPlace solutions:

 l Major changes to business rules or custom tables within a MarketPlace solution will not be 
supported through normal channels as the resulting solution is significantly different from 
the core solution.
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 l If changes are made to any dashboard object or business rule, consider renaming it or 
copying it to a new object first. This is important because if there is an upgrade to the 
MarketPlace solution in the future and the customer applies the upgrade, this will overlay 
and wipe out the changes. This also applies when updating any of the standard reports and 
dashboards.

 l If modifications are made to a MarketPlace solution, upgrading to later versions will be more 
complex depending on the degree of customization. Simple changes such as changing a 
logo or colors on a dashboard do not impact upgrades significantly. Making changes to the 
custom database tables and business rules, which should be avoided, will make an 
upgrade even more complicated.
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